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          Twin Tec User Instructions for 
Twin Tuner Touring Version

CAUTION: CAREFULLY READ INSTRUCTIONS BEFORE PROCEEDING.  
NOT LEGAL FOR USE OR SALE ON POLLUTION CONTROLLED VEHICLES. 

OVERVIEW 
The Twin Tuner touring version P/N TWIN-

TUNER-FL is compatible with 2008 and later H-D® 
touring models with the new 73 pin Delphi® module 
and electronic throttle control. You can easily adjust 
your fuel injection to match the requirements of 
performance parts including camshafts, free flowing 
exhausts, and low restriction air filters. You can add or 
subtract fuel. 

Installation takes only 10-15 minutes and is very 
easy, with no splicing, cutting, crimping, or bulky 
interconnections. All access is at the Delphi ECM. Just 
remove four wires from the ECM connector, insert 
these wires into our small mating connectors, insert 
four new wires from the Twin Tuner into the ECM 
connector, and connect one ground wire. The unit is 
completely encapsulated and impervious to moisture. 
With a very low profile of only ½” and occupying a 
fraction of the space required by competitive products, 
you won’t have a problem finding a place to mount the 
unit.  

Figure 1 – Twin Tuner 

 
You can use the mode and up/down pushbutton 

switches to make fuel trim adjustments in the RPM and 
throttle position ranges required by most applications. 
The fuel trim value is displayed on a bright daylight 
readable LED display. The Twin Tuner also has an 
advanced mode, where you can use the optional USB 

interface and PC Link Tuner software to make precise 
fuel adjustments. The PC Link Tuner software uses the 
same RPM rows and throttle position columns as the 
Dynojet Power Commander. If you have created 
Dynojet Power Commander files for your applications, 
you can use the same values in our tables. You can 
make independent adjustments to the front and rear 
cylinders. 

  The Twin Tuner works great in combination 
with the Twin Scan II+ tuning aid sold by our sister 
company Daytona Sensors. You don’t need a dyno for 
precise tuning. All you have to do is install the Twin 
Scan II+ and ride the bike around some. You can then 
copy the air/fuel ratio corrections calculated by the 
Twin Scan II+ into the PC Link Tuner software.  

INSTALLATION 
1. If the motorcycle is equipped with a security 

system (TSSM module), make sure the system is 
disarmed. Turn off the ignition switch and 
disconnect the battery ground cable before 
proceeding. 

2. Find the Delphi® engine control module (ECM). 
The ECM is usually located under the seat. 

3. Unplug the ECM connector. Cut the cable tie that 
secures the wire conduit. Use a small flat 
screwdriver to depress the tabs on the side of the 
connector and remove the cable cover.  

4. Use a small flat screwdriver to gently slide out the 
green terminal retainer as shown in Figure 2.  

5. Refer to Table 1 for connection details. Remove 
four wires from the ECM connector. Terminal 
numbers are marked on the back side of the ECM 
connector. Original equipment wire color codes 
may vary. Note the color of each wire that you 
remove. We suggest that you mark up Table 1  
with any corrections for future reference.  

6. To release terminals, use the supplied plastic push 
pin as a terminal removal tool. Insert the push pin 
into the round hole between terminal cavities as 
shown in Figure 3. This will release the two 
adjacent terminals. Remove the appropriate 
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terminal. Make sure that the adjacent terminal is 
not dislodged.  

7. Refer to Table 1 and install the four wires from the 
Twin Tuner into the ECM connector.  

8. Use a small side cutter to make a slit in the cable 
conduit so that the four wires you removed can 
exit.  Wrap electrical tape around the cable 
conduit. Reassemble the ECM connector. If the 
green retainer will not slide back into position, 
check for dislodged terminals and push them back 
up. Secure the cable conduit with a supplied cable 
tie. 

9. Refer to Figures 4-6. Use the supplied terminal 
insertion tool to insert the four terminals removed 
from the ECM connector into the two supplied soft 
rubber mini Sure-Seal connectors. To ease 
terminal insertion, first insert the tool into each 
connector cavity and rotate the tool several times 
to remove any rough spots. Lubricate the 
connectors and terminals with isopropyl alcohol 
(rubbing alcohol available at any pharmacy). Do 
not use other lubricants such as WD-40 as 
these will make the connector too slippery and 
you will not be able to hold it securely during 
the insertion process. Start by pushing a terminal 
into the connector by hand. Then use the insertion 
tool to push on the end of the terminal while 
slightly rotating the tool back and forth. Make sure 
each terminal is pushed in so that it is flush with 
the end of the connector as shown in Figure 6. If 
you push a terminal in too far or need to remove it, 
gently pull out on the wire.  

10. Mate the mini Sure-Seal connectors together and 
verify that the wire colors are correctly oriented as 
shown in Figure 4.  

Figure 2 – ECM Connector Retainer Removal 

 

Figure 3 – ECM Connector Terminal Removal 

 

Figure 4 – Twin Tuner Wiring 
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Figure 5 – Terminal Insertion 

 

 

Figure 6 – Terminal Insertion Detail 

 

 

Figure 7 – Completed Wiring at ECM 

 

 

Figure 8 – Completed Twin Tuner Installation 

 
 

11. Connect the Twin Tuner black ground wire to an 
appropriate ground. You can generally find one or 
more screws used for other ground connections 
under the seat or near the ECM.  

12. The Twin Tuner brown wire with Weather Pack 
connector is the data link used for PC 
communications. If not used,  tape up this wire.  

13. Refer to Figure 8 for suggested Twin Tuner 
mounting location. You can use Velcro material to 
secure the unit. 

14. Reconnect the battery ground cable. Do not 
attempt to start the engine until you have 
completed the initial setup.   

 

 

 

 

 

CAUTION: Professional installation is 
recommended. The female Delphi 
Micro64 terminals are delicate and 
easily damaged. Replacement 
terminals are available as P/N           
829-15356827 from Mouser Electronics    
(1-800-346-6873 or www.mouser.com). 
The required Delphi crimping tool is 
P/N 15397700 available from Power & 
Signal Group (1-800-722-5273 or 
www.powerandsignal.com). A 
professional insertion tool for the mini 
Sure-Seal connectors is also available 
as P/N MSS-T-Tool from PEI Genesis 
(1-888-349-9787 or                      
www.pei-genesis.com).   
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Table 1 – Wiring Hookup 

Twin Tuner Wires 

Wire Color To ECM Connector  Signal 

Red 23 Rear Injector  

Orange 28 Front Injector 

Violet 37 Throttle Position Sensor 

White 72 Ignition Switch  

   

ECM Wires (removed from ECM connector) 

Wire Color (ECM terminal) To Mini Sure-Seal Plug Signal 

White/Black (72) 2A Ignition Switch 

Brown/Violet (37) 3A Throttle Position Sensor 

White/Yellow (28) 2B Front Injector 

Green/Gray (23) 3B Rear Injector 

 

INITIAL SETUP   
The Twin Tuner has a 10 position rotary mode 

switch used to select fuel trim parameters to edit, two 
digit LED display, and up/down pushbutton switches to 
change the parameter value. Fuel trim parameters are 
listed in Table 2. Note that the rectangular LED to the 
left of the two digit LED is illuminated for negative 
values. Values represent percent fuel trim. You can 
use a small flat screwdriver to rotate the mode switch. 
You can make parameter changes on-the-fly with the 
engine running.   

Before starting the engine for the first time, turn 
the ignition switch and run/stop switch on. The idle air 
control motor will move to the starting position and the 
fuel pump will be energized for several seconds, 
making an audible buzz. Set the mode switch from 
each position from 0 to 9. The LED display should be 
off in position 0. The LED display should illuminate and 
read 00 in positions 1-9 (unless your Twin Tuner has 
been preprogrammed for some specific application). If 
required, use the up/down pushbuttons to set the 
values for each position to zero. Start the engine and 
verify normal operation. If the engine will not start, or 
runs on one cylinder, recheck connections.  

BASIC TUNING   
Table 2 shows the engine operating ranges 

affected by fuel trim values in terms of RPM and 
throttle position sensor (TPS) values. To properly tune 
an engine, you need to know what fuel trim values are 
required. The only practical means of doing so is to 
use an air/fuel ratio (AFR) metering system based on a 

wide-band oxygen sensor, either directly mounted in 
the exhaust or as part of an exhaust sniffer. It is 
impossible to make accurate adjustments by seat-of-
the-pants or reading spark plugs. For models with 
original equipment oxygen sensors, please read the 
section on page 10. 

If you do not have access to an AFR metering 
system, you can still make some adjustments based on 
the following guidelines.  

1. Aftermarket camshafts will generally increase 
manifold pressure (reduce vacuum) near idle. The 
Delphi speed-density control will compensate with 
excessive fuel resulting in a very rich idle. Try 
reducing the idle fuel by -5% to -10% (parameter 
1).  

2. If the engine runs rough or coughs (backfire 
through the intake) under part throttle cruise 
conditions, try adding 10-15% fuel in the RPM 
ranges where problems are noted (parameters 2 
and 3). 

3. Performance modifications will generally increase 
the fuel requirement at wide open throttle. If the 
engine runs rough or hesitates at wide open 
throttle, try adding 10-15% fuel in the RPM ranges 
where problems are noted (parameters 4-8). 

4. If throttle roll-on response is poor, try adding some 
acceleration enrichment (parameter 9).    
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Table 2 – Mode Switch Settings 

Parameter Fuel Trim Operating Range 
0 Display off – used to prevent inadvertent changes during normal engine operation 

1 Idle 750-1250 RPM 0% TPS 

2 Low cruise 1250-2000 RPM 2.5-50% TPS 

3 High cruise 2000-3750 RPM 2.5-50% TPS 

4 Wide open throttle 1250-2000 RPM 50-100% TPS 

5 Wide open throttle 2000-2750 RPM 50-100% TPS 

6 Wide open throttle 2750-3750 RPM 50-100% TPS 

7 Wide open throttle 3750-4750 RPM 50-100% TPS 

8 Wide open throttle above 4750 RPM 50-100% TPS 

9 Acceleration enrichment (0 = none, 10 = maximum) 

 

If you have access to an AFR metering system, 
either a standalone system such as the Daytona 
Sensors WEGO II or a load control dyno with an 
exhaust sniffer, you are in a much better position to 
make accurate adjustments.  

1. Make sure the engine is fully warmed up and has 
reached normal operating temperature. Run the 
engine at idle. Trim the idle fuel (parameter 0), 
while observing the AFR. Idle AFR should be near 
13.5. Very few applications will require adding fuel 
at idle. Aftermarket camshafts will generally 
increase manifold pressure (reduce vacuum) near 
idle. The Delphi speed-density control will 
compensate with excessive fuel resulting in a very 
rich idle. You will have to subtract some fuel to 
compensate. If you are using sniffer, obtaining 
an accurate idle AFR reading may be difficult 
due to reversion effects. Reversion will result 
in a false lean AFR reading. If the AFR reading 
is above 14.6 before fuel trim, but the engine is 
running reasonably well, you probably have a 
false lean reading.  

2. Run the engine at part throttle near the middle of 
the RPM and throttle position ranges given in 
Table 2 for low and high cruise (parameters 2 and 
2). Trim the fuel so that average AFR readings are 
near 13.8. If you observe a lean spot where AFR 
exceeds 14.6, add more fuel. You are always 
better off with the engine running rich in some 
areas than coughing in one particular lean spot.  

3. Performance modifications will generally increase 
the fuel requirement at wide open throttle. 
However, it is not unusual for some 2-into-1 
exhaust systems to have a torque dip at some 
RPM point where the engine then runs very rich 
and fuel must be subtracted. Do wide open throttle 

runs and record AFR values. Target AFR values at 
wide open throttle are in the 12.8-13.0 range. 
Refer to Table 2 and make appropriate fuel trim 
adjustments in each RPM range (parameters 4-8). 
High compression engines may exhibit spark 
knock at wide open throttle. Spark knock can often 
be eliminated by adding more fuel (AFR in the 
12.0-12.5 range) within the affected RPM range.   

4. If throttle roll-on response is poor or a lean 
transient (high AFR values) is observed, try adding 
some acceleration enrichment (parameter 9).    

 ADVANCED TUNING   
The Twin Tuner also has an advanced mode, 

where you can use the optional USB interface and 
Windows software to check and observe system 
operation (Tuner Log) and make precise fuel 
adjustments (PC Link Tuner).  

PC REQUIREMENTS 
The Twin Tuner connects to your PC by means 

of an optional USB interface (P/N USB-INTF) that is 
also used with our other engine controls. The PC must 
have a free USB port. If you have an older PC without 
USB capability, you cannot use the advanced tuning 
capability.  

We recommend a laptop PC with Pentium 
processor and super VGA display (SVGA with 1024 x 
768 pixel resolution) running Windows 98/ME/XP/Vista. 
Data display is graphics intensive and a high speed 
Pentium processor is recommended. Processors 
slower than 300 MHz will exhibit sluggish program 
loading and response. The PC must have a CDROM 
drive for program loading.  
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PC Link Tuner software includes print 
commands to print downloaded data. The program has 
been tested with Hewlett-Packard laser and inkjet 
printers and Epson inkjet printers. We recommend 
using a color inkjet printer. 

SOFTWARE INSTALLATION 
The software is supplied on CDROM media or in 

the form of a compressed file downloaded from our 
website. The installation process uses InstallShield. 
This industry standard installer is based the new 
Microsoft Windows Installer service that greatly 
reduces potential problems such as version conflicts 
and allows for application self-repair. Since Windows 
98 systems did not originally include the Windows 
Installer service, the required installer software is 
included in the distribution media.  

There are two programs to install: Tuner Log and 
PC Link Tuner. Start by installing Tuner Log. If you are 
downloading software from the web, only download and 
install one program at a time. Before proceeding with 
installation, shutdown any other applications that may be 
running. For Windows Vista, you must disable the User 
Account Control (UAC) during installation. If you are 
not familiar with the UAC, please refer to the Vista 
UAC Tech Note on our website's Tech FAQ for details. 

Use the Windows Explorer or the Run command 
from the Windows Start Menu to launch setup.exe in the 
Tuner_Log  folder on the CDROM or the setup.exe file 
downloaded from our website. InstallShield will install the 
software in an appropriate folder under Program Files. 

Repeat the installation process for PC Link Tuner. 
Use the Windows Explorer or the Run command from 
the Windows Start Menu to launch setup.exe in the 
PC_Link_Tuner  folder on the CDROM or the setup.exe 
file downloaded from our website. InstallShield will install 
the software in an appropriate folder under Program 
Files. 

Once InstallShield has completed the 
installation, Tuner Log and PC Link Tuner will appear 
on the Windows Start Menu. You can then launch them 
just as you would any other Windows program.  

PC Link Tuner software requires the Monospace 
821 BT fixed pitch printer font in order to properly align 
columns when printing. The Monospace 821 BT font is 
included in the distribution media and automatically 
copied to your Windows Fonts folder during 
installation. A backup copy is also placed in the 
program folder. If you accidentally delete this font, use 
the Install New Font command from the Fonts folder 
File menu. The filename associated with Monospace 
821 BT is monos.ttf. 

TWIN TUNER CONNECTION  
Follow the instructions supplied with the optional 

USB interface to install the required USB drivers and 
configure the COM port. Once you have configured a 
COM port number for your new USB Interface, make 
sure that you use this same COM port selection in the 
Tuner Log and PC Link Tuner software. Use the 
“TC88A AND ALL OTHERS” switch setting. 

An adapter harness is supplied with the USB 
Interface for use with the Twin Tuner. Connect the 
alligator clip on the black wire to ground and the 
Packard Weather Pack connector to the mating 
connector on the brown wire from the Twin Tuner.  

Turn the ignition key and engine run/stop switch 
on to provide power to the system. Do not start the 
engine if you want to download or upload data with PC 
Link Tuner. 

TUNER LOG SOFTWARE 
When the engine is running, you can display real 

time engine data on an instrument panel type screen 
as shown in Figure 9 by using the View Real Time 
Data command on the View menu.  

You can also check proper operation of the 
throttle position sensor (TPS) when the run/stop switch 
is on (engine not running). Rotate the throttle through 
the full range of motion. The TPS% value should go 
from zero to 100%.   

Real time engine data is displayed on an 
instrument panel type layout with a round tach gauge 
and bar graph type gauges for all other parameters. 
Status messages are displayed in a separate window. 
If the engine is not running, most values will appear as 
zero or off. 

Displayed parameters include: 

RPM – engine crankshaft RPM (numeric value 
displayed beneath gauge) 

TPS – throttle position (0 to 100%) 

BAT – battery voltage 

FRONT INJ PW, REAR INJ PW – injector pulse 
width in milliseconds (pulse width commanded 
by ECM before fuel trim by Twin Tuner) 

FRONT FUEL%, REAR FUEL% – fuel trim in 
percent (0% means no change) 

STATUS – engine running status and basic 
mode (switch settings used to trim fuel) or 
advanced mode (PC Link Tuner tables used to 
trim fuel) 
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Figure 9 – Real Time Engine Data Display 

 
 

PC LINK TUNER SOFTWARE 
Before the engine is started, you can download 

or upload data with PC Link Tuner.  

After PC Link Tuner is launched, the main 
screen appears blank. You have two options for 
obtaining data for editing. You can open a previously 
saved data file by using the Open File command on the 
File menu or you can download data from an attached 
Twin Tuner unit by using the Download Data From 
Twin Tuner command on the Communications menu. 
Note that Twin Tuner data files use a .dat extension. 
You should create a separate folder to store these 
files.   

Once you have Twin Tuner data, you can edit 
various 3D tables and parameters. 3D fuel trim tables 
are accompanied by chart displays that help visualize 
the data. You can also rotate the 3D chart display for a 
better view of a particular region. You can print the 
data associated with an active table or Twin Tuner 
parameters by using the appropriate Print command 
from the File menu. When you open a file or download 
data from a Twin Tuner, the data is stored in a buffer 
memory. After editing a table, you can save the edits to 
this buffer memory. Once you have completed all your 

edits, you can save the data in buffer memory to a file 
or upload it back to the Twin Tuner by using the 
appropriate command from the File or Communications 
menu. 

Please note that communication is only possible 
if the ignition key and run/stop switch are turned on 
and the engine has not yet been started.  

TWIN TUNER PARAMETERS  
Twin Tuner parameters shown in Figure 10 

control the overall operating mode of the unit and allow 
you to preset parameters without using the switches on 
the unit. Options and parameters that you can set 
include: 

Twin Tuner Version  – when a file is opened or 
data is downloaded, the software automatically 
determines the Twin Tuner version. Do not use EX 
version files or click on the EX option with the standard 
(race) Twin Tuner.  

Basic Mode – fuel trim values are based on 
switch settings. This is the default operating mode. 

Advanced Mode – fuel trim values are based 
on the 3D front and rear cylinder fuel trim tables.  
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Injector Swap on Enrichment Mode – positive 
fuel trim is applied to the opposite injector to 
compensate for fuel distribution problems in some 
applications. This mode is not normally selected. Refer 
to tech support for additional details.  

Enable Manual Trim in Advanced Mode – this 
option is only available in advanced mode and is 
grayed out in basic mode. If this option is selected, 
switch settings 1 to 8 can be used to manually trim the 
3D fuel tables. If this option is not selected, switch 

settings 1 to 8 are ignored (switch setting 9 for 
acceleration enrichment is still active). 

Parameters 1-9 – display fuel trim parameter 
values. Can be used to edit or preset values without 
using the switches on the unit. Fuel trim parameters 
are listed in Table 2.   

User Data – you can enter up to 32 characters 
of user data that will be saved in EEPROM memory. 
User data can contain comments or serial numbers. 

Figure 10 – Twin Tuner Parameters 

 
EDITING 3D TABLE DATA  

You can edit the front and rear cylinder fuel trim 
tables. Before you can edit one of these tables you 
must either open a data file or download data from a 
Twin Tuner unit. Numeric data is always edited on the 
spreadsheet grid. The front and rear cylinder fuel trim 
tables are accompanied by 3D graphs that help 
visualize the data.  

Each table consists of 18 rows from 500 to 
6,500 RPM and 9 throttle position columns from 0% to 
100%. The 6,500 RPM value is used at all higher RPM 
levels. 

After you have edited a table, you must use the 
Save Table Edits To Buffer command from the Edit 

menu to save your edits to buffer memory. If you use 
the Close Table command from the Edit menu, all your 
edits are lost.   

Front and Rear Cylinder Fuel Trim Tables 
The fuel trim values in these tables are only 

active if advanced mode is selected. You can enter fuel 
trim values from -20% to +30% in every cell. Unless 
you have specific experience in trimming individual 
cylinders and the associated fuel distribution problems, 
we suggest that you use the same values for both front 
and rear cylinders. You can edit a table for the front 
cylinder. After saving the table edits to buffer memory, 
you can use the Copy Front Cylinder Trim to Rear 
command from the Edit menu to quickly copy the entire 
table. 
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Figure 11 – Typical Front Cylinder Fuel Trim Table 

 

 
Editing Table Data 

You can edit table data using standard Windows 
copy and paste operations by selecting cells and then 
clicking the right mouse button to pop-up the edit 
menu. You can select cells by dragging the mouse with 
left button down. You can also use the Modify 
command on the pop-up menu. When you enter a 
value, the presence of optional sign (+ or -) or percent 
(%) characters affects the outcome of the Modify 
command as shown in Figure 12.   

Figure 12 – Modify Command  

 

Data Export and Import by Means of Copy 
and Paste 

You might want to export or import 3D table data 
to or from another application such as Microsoft Excel 
and other programs with tables that support copy and 
paste operations. You can directly copy and paste data 
to and from the PC Link Tuner program. In the PC Link 
Tuner program, you can select a range of cells with the 
mouse and right click to bring up a copy and paste 
menu. When you paste data into the PC Link Tuner 
program, the data is automatically checked and any 
out-of-range data corrected.  

Chart Operations 
You can rotate the 3D chart display for a better 

view of a particular region by dragging the mouse while 
holding both mouse buttons down.  

PC Link Tuner is intended to be an open system 
and uses the Component One Chart 7.0 3D charting 
control. The adventurous user can experiment with the 
chart property pages by right clicking on the chart. 
Almost any chart property can be changed. Click on 
the Help button for more information. If you corrupt the 
chart, exit and restart PC Link Tuner.  
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ORIGINAL EQUIPMENT OXYGEN 
SENSORS 

All 2008 and later touring models are equipped 
with dual narrow-band oxygen sensors and a Delphi® 
ECM that supports closed loop AFR control based on 
feedback from the sensors. After the engine has 
warmed up, the ECM attempts to maintain the AFR at 
14.6 during idle and part throttle cruise. Several factors 
must be considered when modifying engines equipped 
with this system: 

1. The engine components are designed to operate 
properly at idle and part throttle cruise with this 
relatively lean 14.6 AFR. Some camshaft profiles 
and aftermarket heads or head modifications may 
result in excessive lean surge or stalling at idle.   

2. If installation of an aftermarket exhaust is planned, 
it must have provision for the oxygen sensors.  

3. At idle and part throttle, the ECM can automatically 
correct for modifications by changing the baseline 
fuel up to ±25%. You can use a scan tool such as 
our Twin Scan II to check what correction the ECM 
is making under closed loop conditions (original 
equipment narrow-band sensors must be 
installed). The correction is referred to as the error 
integrator value and will range from 75-125%. If the 
ECM is running out of adjustment range, you may 
be able to use the Twin Tuner to trim the baseline 
fuel delivery in order to bring the error integrator 
value back to near 100%. However, you will not be 
able to change the target AFR value. This will 
always remain at 14.6.     

4. You can use the Twin Tuner to make corrections at 
wide open throttle (parameters 4-8). If you have 
the Twin Scan II+, you can use it (with WEGO 
sensors temporarily installed) to calculate required 
corrections above 40% TPS on the fuel trim tables.  

5. When using the Twin Scan II+, temporarily 
installing the WEGO sensors in place of the 
original equipment narrow-band sensors 
(disconnect sensors) will cause the Delphi® ECM 
to remain in open loop without any fuel corrections 
that would affect the tuning process. After tuning is 
completed, reinstall the original equipment sensors 
and clear any trouble codes.      

CYLINDER TRIM ISSUES 
Accepted engineering practice is to use the 

smallest possible injectors (in terms of flow) for best 
control at idle and part throttle. The Delphi® style single 
throttle body and similar aftermarket units with 

siamesed runners are subject to fuel imbalance 
problems between the front and rear cylinders.  

The Delphi® ECM synchronizes fuel injection 
events so that the end-of-injection for each cylinder 
occurs when the intake valve is starting to close. At idle 
and part throttle where the injector duty cycle is low, 
the air flow will carry the fuel into the correct cylinder. 
When the fuel injector duty cycle approaches 50%, fuel 
will start being inducted into the wrong cylinder (i.e. 
front injector spraying fuel while rear intake valve is still 
open).  

The Twin Tuner, and similar competitive 
systems such as the Dynojet Power Commander,  
increase fuel delivery by extending the injector pulse 
width. If the fuel trim is more than 5-10%, the fuel will 
continue being injected after the intake valve has 
already closed and this additional fuel will ultimately be 
carried into the opposite cylinder.  

The combined effect of high injector duty cycle 
at wide open throttle and the extended injector pulse 
width make trimming fuel between cylinders difficult 
and somewhat unpredictable. Many customers are 
unfamiliar with this issue and other vendors have been 
reluctant to address it with any specific information or 
suggested techniques.   

In most cases, it is best to use the same fuel 
trim value for both cylinders and tune based on the 
worst case cylinder.  

If an extreme AFR imbalance exists between 
cylinders and a significant amount of fuel must be 
added to one cylinder, you can try using the injector 
swap on enrichment mode (refer to Twin Tuner 
parameters on page 7).   

ELECTRONIC THROTTLE CONTROL 
ISSUES 

All 2008 and later touring models have a throttle 
control actuator (TCA) that also controls idle air. 
Throttle position (TPS) refers to the  position of the 
throttle plate in the TCA, not the twist grip sensor. 
Under warm idle conditions, scan tools will show TPS 
at about 5% (the value will be higher when the engine 
is cold). The Twin Tuner subtracts 5% from the actual 
TPS value. Under warm idle conditions, the Tuner Log 
software will show zero TPS and the Twin Tuner will 
operate in the zero TPS and 1000 RPM cell. A similar 
convention (to subtract 5% from the actual TPS value 
and report warm idle as zero TPS) is also used by 
other systems such as the Dynojet Power Commander. 
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USING DYNOJET POWER 
COMMANDER TUNING DATA 

If you have created Dynojet Power Commander 
files for your applications, you can use the same 
values in our tables. A typical Power Commander fuel 
table is shown in Figure 13. The TPS columns are the 

same as used in our tables and the RPM rows are very 
similar. For intermediate RPM rows in our tables, such 
as 1,250 RPM, you can enter values approximately in 
between the values in the Power Commander 1,000 
and 1,500 RPM rows. For Power Commander files that 
have a single fuel table, use the same values for both 
cylinders with the Twin Tuner.  

Figure 13 – Typical Dynojet Power Commander Fuel Table 

 


